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Opening Survey
Welcome!
Please complete the survey at
https://www.ChrisSpackman.com/2024-10-29-intro-survey.html.
Or, use this QR code:
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Brief Discussion

Brief discussion of the survey.

Were you able to understand the form?
Did you use the Google Translate app (or similar) to read the form?
Has anyone had experience living in a different culture and different
language?

If it wasn’t as obvious as a sledgehammer, we’re trying to experience how some
families experience school communications.
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Today’s Nagare

Introductions and brief tech familiarity conversation
Legal requirements and generally “Why are we here?”
Translating “documents” (for broad definitions of “document”)
Translating slides
Creating multilingual forms — this one could be fairly meaty
Videos, other multimedia, and subtitles — if you don’t need it, you prolly
need it
Q & A and wrap up
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About Chris Spackman

Professional History
Taught K-12 EFL (English as a Foreign Language) in Japan, 1995 – 2008
Earned MA TESOL and Ohio ESL K-12 teaching license in 2010
Work in K-12 ESOL for The Graham Family of Schools since 2010
Teach adult ESOL for the Basic English program at Columbus State
Community College since 2016
Know English and Japanese; learning Spanish
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Contact Me

You can reach me at:

Email: spackman.1@thecharlesschool.org (work)

Email: osugisakae@gmail.com (personal)

Email: chris@chrisspackman.com (personal)

Social Media: @chris_spackman@twit.social (Mastodon)

Chris Spackman The Graham Family of Schools & Columbus State Community College
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Another QR Code
Please go to https://www.ChrisSpackman.com/2024-10-29.html for links
we will use today.
Or, use this QR code:
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Why We Are Here

Our goals for today are:

Understand legal requirements for language access
Look at some Google tools to support English Learners
Loot at some Google tools for multilingual family engagement

But first, let’s preview some vocabulary.
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Vocabulary describing the Field

“ESL” is “English as a Second Language”. It is outdated but still used.

TESOL: Teacher of / Teaching English to Speakers of Other Languages
ESOL: English for Speakers of Other Languages

EAL: English as an Additional Language; recognizes that English is often
a 3rd or 4th or more language

ENL: English as a New Language; avoids counting the student’s languages

There are many more. I prefer ESOL in the k-12 context.
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Vocabulary describing the Students
EL: English Learner; currently the most popular term and acronym

ELL: English Language Learner; ELL is outdated
EMEB: Emergent Multilingual / Emergent Bilingual; most accurate, but not

widely used
MLL: Multi-Lingual Learner; also sometimes just ML
LEP: Limited English Proficient; very outdated, but still the legal term

L1: Language 1; the student’s first or preferred language

I prefer EMEB because it includes both 1) the student is working toward
multilingualism and 2) the student is not there yet. When an EMEB student
places out of ESOL services, they are multilingual or bilingual.

Chris Spackman The Graham Family of Schools & Columbus State Community College
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Legal Requirements

The DOJ and DOE are pretty specific about language access requirements:

“Schools must communicate information to limited English proficient
parents in a language they can understand about any program, service,
or activity that is called to the attention of parents who are
proficient in English” (emphasis added)

Chris Spackman The Graham Family of Schools & Columbus State Community College
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Legal Requirements
“This includes, but is not limited to, information related to:”
registration and enrollment in
school and school programs
requests for parent permission
gifted and talented programs
parent handbooks
report cards
parent-teacher conferences

student discipline policies and
procedures
special education and related
services
meetings to discuss special
education
language assistance programs

from: https://www2.ed.gov/about/offices/list/ocr/ellresources.html
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Preferred Language Identification Process

Families complete Language Usage Survey (LUS) at registration. It asks
about:

languages used at home
student’s first language
preferred school communications languages
(and a few other things)

Registrar or ESOL Coordinator goes through LUS forms looking for families
with other languages at home
Someone communicates family language preferences to school staff

Chris Spackman The Graham Family of Schools & Columbus State Community College
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https://education.ohio.gov/Topics/Student-Supports/English-Learners/Identification-Reclassification-and-Monitoring/Language-Usage-Survey
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Google Tools (Basics)

The tools we will talk about are . . .

Google Translate
Google Docs
Google Sheets
Google Slides
Google Forms
Google Drawings (doesn’t have its own page)

Chris Spackman The Graham Family of Schools & Columbus State Community College
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https://translate.google.com/
https://docs.google.com/document/u/0/
https://docs.google.com/spreadsheets/u/0/
https://docs.google.com/presentation/u/0/
https://docs.google.com/forms/u/0/
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Google Translate
Google Translate site can:

translate text (including voice input)
create translated images
translate presentation slide decks
translate websites

The app for iPhone and Android is very useful. It also:

has conversation mode
can translate text through the camera in real time

Chris Spackman The Graham Family of Schools & Columbus State Community College
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Google Translate (cont.)

Don’t translate individual words; use the word in a sentence to get better
results
Students choose what to use in class:

they may not want everything translated for them
they may want to translate things themselves
they should have the option of using a phone, even if generally not allowed

Chris Spackman The Graham Family of Schools & Columbus State Community College
Supporting English Learners and Engaging Families with Google (Translate) Tools



Survey Nagare About Why Vocab When Basic Tools Advanced Tools Do’s & Don’ts Wrap Up Links Copyright

Google Docs
Currently, only Google Docs has Translate built in. Translating Google Docs is
pretty straightforward:

Create document;
Go to Tools ⇒ Translate document;
Choose a language; click Translate;
A new document will open with the translated content

I always name files with the codes for the language:
“Letter Home (en)” and “Letter Home (es)”.

Chris Spackman The Graham Family of Schools & Columbus State Community College
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Google Sheets
You can use a spreadsheet to keep table of commonly used translations
(auto-updates on load, so always most recent / best translations)

Example of a multilingual reference spreadsheet
Chris Spackman The Graham Family of Schools & Columbus State Community College
Supporting English Learners and Engaging Families with Google (Translate) Tools

https://docs.google.com/spreadsheets/d/1QjHJgSB4IRyyPhO566xdGjp0jg4U4Xd-aXKlL_HgleI/edit?usp=sharing
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Google Sheets (cont.)
To get meaning or synonyms, use “IMPORTXML”. The specific functions are:

translate: =IF(A4="", "", GOOGLETRANSLATE("content","EN","L1"))

synonym: =IMPORTXML("https://www.thesaurus.com/browse/word","(//h2)[1]/following::li[position()<4]//text()")

I like to put the English word or meaning in one column, and then have the
translation refer to the cell in that column:

=IF(A4="", "", GOOGLETRANSLATE(A4,"EN","FR"))

=IMPORTXML("https://www.thesaurus.com/browse/"&A4,"...)

The IF statement lets you prefill cells but leave them blank until there is a word
to translate.

Chris Spackman The Graham Family of Schools & Columbus State Community College
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Google Slides

When creating new slides, I recommend using a template that has the
“translation” script already installed. The code is from Google, and it does not
connect anywhere else.

Presentation slides with the translation script

Google dev page on creating the “translate” add-on
I prefer using the AppScript, to guarantee student privacy
When using external web sites and extensions and addons: privacy ????

Chris Spackman The Graham Family of Schools & Columbus State Community College
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https://developers.google.com/apps-script/add-ons/editors/slides/quickstart/translate
https://docs.google.com/presentation/d/1nEXUVQaheyQc133we28SJNg_XN4BYQhd3mxS7nVPrXM/edit?usp=sharing
https://developers.google.com/apps-script/add-ons/editors/slides/quickstart/translate
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Google Slides
For existing Google Slides that need translated, the easiest way is to:

Download as PPTX (File ⇒ Download ⇒ Microsoft PowerPoint (.pptx))
Upload to Google Translate site
Download the translation (it will be PPTX)
Upload to Google Drive
Convert back to Google Slides (File ⇒ Save as Google Slides)

Note: files larger than 10 MB will not be translated. Remove or resize images to
get PPTX file under 10 MB. (Hint: PPTX files are just zip files.)

Chris Spackman The Graham Family of Schools & Columbus State Community College
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Google Forms
Choices, choices, choices, and until recently, none of them great.

Separate forms (update! much easier with new AppScript for Forms)
One form with several languages per question
One form with sections for each language

All have their drawbacks. Biggest is often the extra time needed for collating the
data later. There are add-ons / extensions, but the AppScript is only a little
more annoying, and completely safe.
I have a video on YouTube with more info how to create multilingual forms with
Google Translate.
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https://github.com/OsugiSakae/translate-google-forms
https://forms.gle/VBnqSUjrkNEiNn4p6
https://forms.gle/4a5m33MRZEe5vwoaA
https://youtu.be/TXI9-IsRk7M
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Google Drawings
Graphics do NOT automagically get translated (yet)!

Graphics with text are more difficult to translate
Best to avoid text in graphics (best choice, in my opinion)
Google Translate can translate images (second best choice)
Google Drive can (sometimes) do OCR
In emails / newsletters, should provide individual translated graphics

so, better to avoid text in graphics

Chris Spackman The Graham Family of Schools & Columbus State Community College
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Google Tools (Advanced)

Google Meet
Google Gemini
Google NotebookLM
YouTube

Chris Spackman The Graham Family of Schools & Columbus State Community College
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https://meet.google.com
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Google Meet

Turn on live captions
Each user can turn on translated live captions
Need to make families aware of it, though

Chris Spackman The Graham Family of Schools & Columbus State Community College
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Google Gemini

LLMs are great for creating text in a lot of languages.

Create readings for students, in all the languages, at all the levels
reading practice, grammar explanations, summaries, etc.

Translate subtitles, including the timings!
Soooo much more

When facts matter, I check the English, then ask for translations, questions, etc.
Tip: have a conversation, not just a one-and-done request

Chris Spackman The Graham Family of Schools & Columbus State Community College
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Google NotebookLM

NotebookLM is new-ish and I’ve not had a chance to use it much.
If what I’ve heard is accurate, it could become very useful for school staff soon.

good for school documents, class texts, etc.
might translate entire handbooks, registration forms, etc?

Chris Spackman The Graham Family of Schools & Columbus State Community College
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YouTube

YouTube is an excellent resource for educational videos, especially for newcomers.

Find content area videos in students’ L1
Get transcripts of videos
Add subtitle tracks
Add audio tracks?

Chris Spackman The Graham Family of Schools & Columbus State Community College
Supporting English Learners and Engaging Families with Google (Translate) Tools
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YouTube (cont.)
Content Area Videos

Google Translate your search
high school algebra solving 2-step equations ⇒ Álgebra de secundaria:
resolución de ecuaciones de dos pasos

Search YouTube with the translated text
Look through a few of the vids
Translate the transcript to English, or turn on English captions
Share video with student

Chris Spackman The Graham Family of Schools & Columbus State Community College
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YouTube (cont.)
Transcripts

Youtube — if no translated subtitles, this is the easiest way
Copy transcript; paste into a Google Doc
Fix up a bit (line breaks can confuse Google Translate sometimes)
Translate in Google Docs, Google Translate, or ask Google Gemini to
translate
You now have translated transcripts.

You do NOT have translated subtitles: document is separate from video; no
timing information

Chris Spackman The Graham Family of Schools & Columbus State Community College
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YouTube (cont.)
Subtitles
If you publish videos on YouTube, use https://studio.youtube.com to add
translated subtitles

Select the video to work on
Click on Subtitles from menu on the left side
Click “Add Translation” and choose the language
Double check and edit as necessary

For many videos you don’t own, you have to fall back to auto-translated
subtitles, if available.

Chris Spackman The Graham Family of Schools & Columbus State Community College
Supporting English Learners and Engaging Families with Google (Translate) Tools
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Do’s & Don’ts
Do’s

Give both English and L1 when sending translated documents home
Often, the English can be helpful if the L1 translation is unclear.

Consider “plain language” and “simple English” when writing documents
that will be translated.

Using plain language can help readers understand and maybe get more
accurate translations.

Similar to the advice for working with interpreters. Nutshell: keep sentences
short and simple.
Always turn on subtitles / captions when showing videos in class.

Chris Spackman The Graham Family of Schools & Columbus State Community College
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Do’s & Don’ts (cont.)
Don’ts

Do NOT use your world language teachers as interpreters or translators
Not in their contracts (usually)

Translation and interpretation are distinct skills. Speakers of a language are
not automagically qualified to interpret or translate that language.

Do NOT translate everything for your newcomer students
Newcomers need to learn English. That won’t happen as quickly if they
receive everything in their L1.
Okay, so then what should you translate?

Chris Spackman The Graham Family of Schools & Columbus State Community College
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Q & A; Wrap Up

Questions? Answers? Comments?
Please find these slides, and links to other resources from today, at
chrisspackman.com
My “professional” email address is chris@chrisspackman.com.
My work email is spackman.1@thecharlesschool.org.
My Gmail (for the shared documents) is osugisakae@gmail.com.
I’m on Mastodon at @chris_spackman@twit.social.

Chris Spackman The Graham Family of Schools & Columbus State Community College
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https://www.ChrisSpackman.com/Educator-Resources/pd/2024-10-29-itip-google/
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Links

These next slides include the text of all the URLs in this presentation.

https://developers.google.com/apps-script/add-ons/editors/slides/
quickstart/translate

https://docs.google.com/document/u/0/

https://docs.google.com/forms/u/0/

https://docs.google.com/presentation/d/1nEXUVQaheyQc133we28SJNg_
XN4BYQhd3mxS7nVPrXM/edit?usp=sharing

https://docs.google.com/presentation/u/0/
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https://developers.google.com/apps-script/add-ons/editors/slides/quickstart/translate
https://developers.google.com/apps-script/add-ons/editors/slides/quickstart/translate
https://docs.google.com/document/u/0/
https://docs.google.com/forms/u/0/
https://docs.google.com/presentation/d/1nEXUVQaheyQc133we28SJNg_XN4BYQhd3mxS7nVPrXM/edit?usp=sharing
https://docs.google.com/presentation/d/1nEXUVQaheyQc133we28SJNg_XN4BYQhd3mxS7nVPrXM/edit?usp=sharing
https://docs.google.com/presentation/u/0/
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Links (cont.)

https://docs.google.com/spreadsheets/d/
1QjHJgSB4IRyyPhO566xdGjp0jg4U4Xd-aXKlL_HgleI/edit?usp=sharing

https://docs.google.com/spreadsheets/u/0/

https://education.ohio.gov/Topics/Student-Supports/
English-Learners/Identification-Reclassification-and-Monitoring/
Language-Usage-Survey

https://github.com/OsugiSakae/translate-google-forms (AppScript)
https://forms.gle/4a5m33MRZEe5vwoaA (form with sections for each
language)

Chris Spackman The Graham Family of Schools & Columbus State Community College
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https://docs.google.com/spreadsheets/d/1QjHJgSB4IRyyPhO566xdGjp0jg4U4Xd-aXKlL_HgleI/edit?usp=sharing
https://docs.google.com/spreadsheets/d/1QjHJgSB4IRyyPhO566xdGjp0jg4U4Xd-aXKlL_HgleI/edit?usp=sharing
https://docs.google.com/spreadsheets/u/0/
https://education.ohio.gov/Topics/Student-Supports/English-Learners/Identification-Reclassification-and-Monitoring/Language-Usage-Survey
https://education.ohio.gov/Topics/Student-Supports/English-Learners/Identification-Reclassification-and-Monitoring/Language-Usage-Survey
https://education.ohio.gov/Topics/Student-Supports/English-Learners/Identification-Reclassification-and-Monitoring/Language-Usage-Survey
https://github.com/OsugiSakae/translate-google-forms
https://forms.gle/4a5m33MRZEe5vwoaA
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Links (cont.)

https://forms.gle/VBnqSUjrkNEiNn4p6 (form with several languages per
question)
https://gemini.google.com

https://meet.google.com

https://notebooklm.google.com/

https://simple.wikipedia.org/wiki/Main_Page (simple English)
https://studio.youtube.com

https://translate.google.com/

Chris Spackman The Graham Family of Schools & Columbus State Community College
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https://forms.gle/VBnqSUjrkNEiNn4p6
https://gemini.google.com
https://meet.google.com
https://notebooklm.google.com/
https://simple.wikipedia.org/wiki/Main_Page
https://studio.youtube.com
https://translate.google.com/
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Links (cont.)

https://twit.social/@chris_spackman

https://www.ChrisSpackman.com/

https://www.ChrisSpackman.com/2024-10-29.html (redirects to
2024-10-29-itip-google)
https://www.ChrisSpackman.com/2024-10-29-intro-survey.html
(redirects to a Google Form)
https://www.ChrisSpackman.com/Educator-Resources/pd/
2024-10-29-itip-google/index.html

Chris Spackman The Graham Family of Schools & Columbus State Community College
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https://twit.social/@chris_spackman
https://www.ChrisSpackman.com/
https://www.ChrisSpackman.com/2024-10-29.html
https://www.ChrisSpackman.com/Educator-Resources/pd/2024-10-29-itip-google/index.html
https://www.ChrisSpackman.com/2024-10-29-intro-survey.html
https://www.ChrisSpackman.com/Educator-Resources/pd/2024-10-29-itip-google/index.html
https://www.ChrisSpackman.com/Educator-Resources/pd/2024-10-29-itip-google/index.html
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Links (cont.)

https://www.plainlanguage.gov/guidelines/

https://www.youtube.com

https://www2.ed.gov/about/offices/list/ocr/ellresources.html

https://youtu.be/TXI9-IsRk7M (creating multilingual forms)
mailto:chris@chrisspackman.com

mailto:osugisakae@gmail.com

mailto:spackman.1@thecharlesschool.org
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https://www.plainlanguage.gov/guidelines/
https://www.youtube.com
https://www2.ed.gov/about/offices/list/ocr/ellresources.html
https://youtu.be/TXI9-IsRk7M
mailto:chris@chrisspackman.com
mailto:osugisakae@gmail.com
mailto:spackman.1@thecharlesschool.org
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Copyright / Copyleft

This document is copyright ©2024 Chris Spackman.
These slides are licensed under a Creative Commons Attribution-ShareAlike 4.0
International License

Please see ChrisSpackman.com for editable versions of resources from our PD
today.

Last edited: 2024-10-13

Chris Spackman The Graham Family of Schools & Columbus State Community College
Supporting English Learners and Engaging Families with Google (Translate) Tools

http://creativecommons.org/licenses/by-sa/4.0/
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